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I. Executive Summary 

 

The SFASU Foundation, on behalf of the East Texas Research Center (ETRC), Ralph W. Steen 

Library, Stephen F. Austin State University (SFA), was awarded a Summerlee Foundation grant 

to research slavery in Texas through the lens of newspaper advertisements, articles and capture 

notices for runaway slaves. A $10,000 grant from the Summerlee Foundation supported the 

project. The ETRC hired six student assistants for 780 hours of digital research.  

 

The students looked at newspaper issues from 1835-1865 in the collection of the Texas Digital 

Newspaper Program. The researchers reviewed 62.5 percent (4,735) of the available content, 

found 1,116 records and input their findings into a Microsoft Excel database. This research was 

then organized and added to the Texas Runaway Slave Project (TRSP) website, which is part of 

the ETRC’s publicly available digital archives. All the records found by the student assistants are 

now online. At present the TRSP documents 1,285 runaway slaves from Texas in 1,058 

advertisements, articles and capture notices. Google Analytics data shows that students, scholars 

and genealogists worldwide are using the project research.  

 

 

II. Program Changes 

 

The project manager modified the work plan and schedule submitted in the grant to match 

changes to the award amount and to conform to university labor policies.  

 

Revisions 

 Labor: The project manager allocated $10,000 for student labor (800 hours). Six students 

were hired; five for 150 hours each and one for 50 hours.  

 Timeline: Student research on the project began May 12, 2014 to coincide with the 

beginning of university’s summer academic calendar. Student research concluded 12 

weeks later on July 31, 2014.  

 

 

III. Accomplishments 

 

A. Grant Objectives 

  

1. To support the further development of the Texas Runaway Slave Project 

(http://digital.sfasu.edu/cdm/landingpage/collection/RSP). 

 

Between the students and the project manager, 97.2 percent of relevant newspapers issues 

indexed by the Texas Digital Newspaper Project are complete. The only online content that 

remains is several German-language newspapers. All the student research is online and fully 

searchable to users. 

 

Table 1 illustrates the significance of the Summerlee Foundation-funded research to the TRSP. 

The students were able to do 125 percent more research in two months than the project manager 

accomplished in 26 months. The student’s research saved the project manager almost three years 

http://digital.sfasu.edu/cdm/landingpage/collection/RSP
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(2.72) of individual labor. This contribution cannot be overstated. The grant-funded research 

now represents a majority (55.6 percent) of the total project research. There is still a lot of work 

to do, but it will be much more manageable because of the Summerlee Foundation support. 

 

Table 1: TRSP Research Statistics 
 Reviewed by Students Reviewed by Project Manager To-Do Total 

 5/12/14- 

6/16/14 

6/17/14-

7/31/14 

12/12- 

10/1/13 

10/2/13-

6/16/14 

6/17/14-

7/31/14 

8/1/14- 

1/16/15 

  

TDNP Digital 2,258 2,477 1,115 1,022 495 0 212 7,579 

LOC Digital
1
 0 0 0 0 0 310 0 310 

Microfilm
2
 0 0 192 36 176 437 1,930 2,772 

Original
2
 0 0 0 0 0 0 343 343 

Sub-Total   2,258 2,477 1,307 1,058 671 741   

Total 4,735 3,777 2,485 11,004 
1
 The Library of Congress digitized the Dallas Weekly Herald (1855-1865). 

2
 The project manager is still researching new microfilm and original issues on the Library of Congress’ Chronicling 

America newspaper index. The total number may be within as little as a few hundred or as many as several thousand 

more. 

 

B. Marketing / Publicity 

 

Due to a quirk in the JavaScript for the Digital Archives, Google Analytics was not activated for 

the TRSP website until November 2, 2014. In the 80 days since then (as of January 20, 2015) 

there were 312 new visitors to the website landing page. Extrapolating this data, the project 

manager estimates there were 1,423 unique visitors in 2014. 

 

Google Analytics provides a plethora of other data. Below, Table 2 shows the cities where the 

TRSP website is generating the most traffic. It should be assumed that the overwhelming 

majority of the Nacogdoches usage is from the project manager’s quality control. Outside of 

Nacogdoches, however, the website had 7,916 pageviews, 2,698 unique pageviews and 524 

entrances.  

 

Table 2: TRSP Website Traffic 
Locations Pageviews Unique Pageviews Entrances 

Nacogdoches, TX 9,479 3,410 175 

Long Beach, CA 2,024 728 106 

Houston, TX 741 256 48 

Austin, TX 439 167 16 

Fort Worth, TX 312 115 26 

New York, NY 300 69 7 

Hattiesburg, MS 162 58 14 

Bowling Green, KY 151 42 7 

Inglewood, CA 136 34 1 

Beaumont, TX 124 33 1 

Dallas, TX 120 27 8 

United Kingdom 570 211 47 

All Others 2,837 958 243 

Totals 17,395 6,108 699 
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Google Analytics defines Pageviews as “the total number of pages viewed. Repeated views of a 

single page are counted. Unique Pageviews are “the number of visits during which the specified 

page was viewed at least once. A unique pageview is counted for each page URL + pate Title 

combination.” Entrances are “the number of times visitors entered your site through a specified 

page or set of pages.” The information in Table 2 is very encouraging for the future of the 

project. People not only in Texas, but around the United States and in the United Kingdom, are 

using the website. The sustained usage of the website is also borne out in how the TRSP fares in 

Internet searches (Table 3). Even searches that don’t specifically use the project name 

consistently appear on the first page of results across Google, Yahoo and Bing. 

 

Table 3: Search Engine Results for Project Terminology 

Search Term Google Yahoo Bing 

Texas Runaway Slave Project 1st 1st 1st 

Texas Runaway Slaves 1st 5th 1st 

Runaway Slaves and Texas 1st 6th 1st 

Runaway Slave Project 1st 1st 1st 

Runaway Slaves 32nd 226th >500th 

 

 

IV. Evaluation 

 

A. Researchers  

 

The students as a team exceeded expectations and completed all of the research assigned to them. 

They reviewed 4,735 total newspaper issues in 12 weeks. The data suggests that the students 

became much more efficient as their research progressed (Table 4). Even though they worked 

significantly fewer hours in the final six weeks, they worked at a faster rate and reviewed more 

newspapers.   

 

Table 4: Issue Review Rates for Student Researchers 

 Hours Total Rate (issues/hour) 

Grant Estimate 782
1
 4,692 6.0 

Weeks 1-6 4081 2,258 5.5 

Weeks 7-12 354 2,477 7.0 

 

Several student researchers were exceptional (Table 5). Student A reviewed the Austin Texas 

State Gazette, Houston Telegraph and Texas Register, et al. and managed to be both economical 

with their time (7.31 issues/hour) and productive (526 database entries, 47.1 percent of the 

student total). Student B was the fastest researcher, working predominantly on San Antonio and 

Galveston newspapers, and perfected skimming the newspapers for key words. Together 

Students A and B accounted for 68.5 percent of the newspapers researched and each individually 

looked at more newspapers than the rest of the team combined.  

 

                                                           
1 When coming up with the hourly issue estimate for the grant, the project manager did not account for the training 

each student researcher would need to receive before working independently on the TRSP. A conservative estimate 

for training time per student was three hours (18 hours total). 
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Table 5: Student Researcher Productivity 

Student 
Hours 

Completed 

Issues 

Reviewed 

Database 

Entries 

Issues/ 

Entry 

Issues/ 

Hour 

Student A 210.01 1,535 526 2.92 7.31 

Student B 175.00 1,719 229 7.51 9.83 

Student C 171.39 610 108 5.65 3.56 

Student D 149.88 521 203 2.57 3.48 

Student E 39.75 210 16 13.13 5.28 

Student F 33.92 140 34 4.12 4.13 

Total 779.95 4,735 1,116 4.24 6.07 

Project Manager n/a 3,777 714 5.29 n/a 

Project Total n/a 8,512 1,830 4.65 n/a 

 

That is not to say that the other student researchers were not proficient. The newspaper research 

was assigned at random and there were a number of variables in every issue that might make one 

newspaper go very quickly and another one agonizingly slow. Some of those include: 

 

a) Legibility – Some newspapers were scanned out-of-focus, too dark, or too light. 

 

b) Size – Newspapers ranged in length (typically 1-4 pages) and width (typically 2-8 columns). 

An important variable since researchers were asked to skim the whole newspaper for articles 

as well as the more common and distinctive advertisements and capture notices.    

 

c) Content – Some newspapers featured more articles, which tend to be longer and more 

tedious to transcribe, than advertisements and capture notices. 

 

d) Noticeability – The runaway slave advertisements in some newspapers, like the Houston 

Morning Star, are unremarkable with no title or bold font to make them standout. The article 

to advertisement ratio and location of advertisements varies with each publication. 

 

For example, Students A and D got bogged down by the Austin Texas State Gazette, which all 

by itself accounted for 41 percent (455 total) of the student’s project database entries. In 1850 

this newspaper was three columns wide and eight pages long (half the normal width but twice the 

standard length). Student C was both very meticulous and, for whatever reason, happened to find 

lots of long articles. Students E and F worked hard during their limited time on the project.  

 

All the students, to one level or another, struggled with the level of detail required by the project. 

This will be covered in more depth in the evaluation of the project director. 

 

B. Budget  

 

The project manager did not plan for student fringe benefits (workers compensation and 

healthcare) and went over-budget by $111.40. At 780 hours of research, the project manager 

received a budget update from the university comptroller and suspended research. The Ralph W. 

Steen Library covered the additional cost.  
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Table 6: Grant Expenditures 

Summerlee Funding $10,000.00 

Student Wages (780 hours x $12.50/hour)  -9,750.00 

Student Benefits -$361.40 

Total -$111.40 

 

C. Management 

 

1. Project Manager 

 

Preparation for the project was good. As noted in the six-month report, The Ralph W. Steen 

Library information technology department installed a four-computer suite in the ETRC’s 

workroom (see Figure B) and the project manager created an 18-page procedure and 

troubleshooting manual (see Appendix).  

 

Each student received roughly three hours of training to begin the project and ongoing 

supervision and quality control over the duration of their research. Training consisted of a step-

by-step review of the procedure manual as the student researched their first newspaper issues. 

Students started working on the project at different times, which was an unanticipated but 

welcomed outcome because the project manager was able to train each student individually. 

 

For the first couple of weeks, the project manager quality-controlled the research of each student 

on a daily basis. The students all struggled with the level of detail required, especially project-

specific nuances of punctuation, formatting, and file-naming. After each workday, the project 

manager identified mistakes to be discussed and corrected the following workday. This was a 

successful method for correcting errors and employed on a case-by-case basis. Some students 

were more mistake-prone than others. Overall, while there were a lot of quality control issues 

through May, the students seemed to find their own working rhythms through June and July. 

 

Primary quality control for the project commenced in late July 2014 as the students completed 

their research hours. The project manager reviewed each student’s research, combining all six 

spreadsheets into a master spreadsheet August 8th. From August 4th through November 3rd, the 

project manager more thoroughly reviewed every student database entry, finding and fixing 

mistakes, looking for duplicates (single runaway slaves identified by separate student researchers 

as different people), and formatting transcripts. Over the same three-month period, six batches of 

content were sent to the website content manager for upload. In December, the project manager 

reviewed every single record on the TRSP website (about 1,200), looking for errors missed 

during the first two stages of quality control. Four sets of revised records were uploaded in 

December. At the start of the New Year, the project manager compared the online content to the 

master spreadsheet and found outlying records which had slipped through the cracks of the 

quality control and upload. These were uploaded in seven batches ending January 22, 2015. 

 

The project manager underestimated how intensive the quality control for the project would be. 

It was a painstaking process at every phase of the post-research review. The most time-

consuming fixes were:  
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a) The project manager edited, reformatted or redid every single student PDF transcription (more 

than 1,000 total). The purpose of the transcriptions was to as closely as possible replicate the 

original runaway materials in PDF form, down to the text, formatting, and special characters, so 

that researchers could have a true-text copy of the original material. The students did their best 

based on the procedure manual, but it was not enough. With all the instruction and quality 

control the project manager did while the students were working, this is the one aspect that was 

overlooked.  

 

b) One of the main fields in CONTENTdm, the website software used by the project to organize 

the research, is ObjectFileName. This was the field in the master Microsoft Excel spreadsheet for 

the JPEG image (Luke02.jpg), but there was no field in the spreadsheet for the file name without 

the extension (Luke02). Therefore, this field for most of the material uploaded between August 

and October defaulted to “0.” Website users could search for runaway slaves by Name, but when 

browsing there was no sequencing. The project manager, content manager, and a metadata 

librarian had to make this fix manually. 

 

Also, small mistakes became big mistakes (and incredibly difficult to spot) in a Microsoft Excel 

database with forty fields and over 12,000 rows of data and in the very finicky CONTENTdm 

software. Punctuation was the main issue. For example: 

 

a) The CONTENTdm software does not recognize the en-dash or em-dash. Every time there is a 

special character that the software does not recognized, the software replaces that item with a 

question mark inscribed in a diamond (�) in that spot on the website. Almost all the runaway 

slave advertisements uploaded had en-dash and em-dashes that had to be replaced with either a 

single or double dash.   

 

b) Students did not realize a comma denotes continuation while a semi-colon indicates a break. 

This was an issue in the Repetition and Possessions fields most commonly, but also when there 

were multiple names associated with one field.  

 

All in all, the research, content upload and quality control concluded within a year of the grant 

award and roughly within the timeline set forth in the grant. For this the project manager should 

be commended. The regular work supervisor of the project manager is also due recognition for 

accommodating the intensive quality control. The grant budget estimated the project manager’s 

labor at two hours per week for the fall 2014 semester. In reality, the project manager devoted at 

least 30 hours per week to finishing the grant on schedule.  

 

2. The co-Project Manager and Website Content Manager  

 

The website content manager did not participate in the supervision of students or the quality 

control of their work. The website content manager’s role was to upload the grant research to the 

TRSP website. This was tedious and repetitive work executed perfectly by the website content 

manager over and over.  

 

 

 

http://digital.sfasu.edu/cdm/search/collection/RSP/searchterm/%EF%BF%BD
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V. Research Results 

 

Student productivity is measured throughout the report in terms of database entries. This is not 

the same metric as individual runaway slaves, which is how the website is organized, and there is 

a good reason for that. The best way to explain is to look at an example (Table 7).  

 

Table 7: Research Crossover 
Column 1 Column 2 Column 3 Column 4 

Dave01 

Shade01 

Fortune01 

Tom09 

Jacob01 

(a) Version 1 

The Southern 

Intelligencer 

Student A 

(b) Version 2 

The San Antonio 

Ledger 

Student B 

(b) Version 2 

Daily Ledger 

Project Manager 

 

  

Runaway slaves Dave, Shade, Fortune, Tom and Jacob were advertised for by R. T. Johnson and 

John C. Edwards of Freestone County, Texas in July and August 1858. Two versions of the 

advertisement appeared in three total newspapers. Three different researchers found this group in 

their individual research. Each made five Microsoft Excel database entries to document the 

group (one for each runaway slave). Researcher crossovers like the table are typical in the TRSP 

research. While it would be nice to be able to attribute the five runaway slaves to a specific 

researcher or to grant-funded research versus the project manager’s research, it is not possible. 

The project manager felt database entries would be the best measure of student output because 

even if there are multiple iterations of the same material, the researcher still made a record for 

each. The example above is measured as five runaway slaves, two advertisements (a and b) and 

15 database entries. The TRSP website shows the information in columns two through four 

collated for each of the five runaway slaves.  

 

Another important note about the research was that it was not confined only to runaway slaves in 

Texas. The project manager instructed the students to record any article, advertisement or 

capture notice irrespective of geography. The breadth of location is best illustrated by articles 

(see Table 8). Context is the best reason for recording the non-Texas material. Texas newspaper 

editors often reprinted stories from other newspapers around the country. The project manager 

felt that knowing what Texans read about runaway slaves elsewhere might be useful to scholars. 

For example, Editor R. W. Loughery of the Marshall Texas Republican reprinted many articles 

panning the unwillingness of abolitionist officials in Massachusetts, New York and Pennsylvania 

to enforce the Fugitive Slave Act of 1850. The scathing stories promoted Southern solidarity and 

reminded local subscribers that they could expect no cooperation if their own slaves absconded 

North.  

 

 

 

 

 

 

 

 

 



 
 

8 
 

Table 8 – Newspaper Articles  

State Runaways Articles Database 

Entries 

 State Runaways Articles Database 

Entries 

TX 163 94 119  MO 15 2 2 

MA 9 14 15  MD 201 2 2 

NY 10 13 13  VA 11 2 2 

PA 11 8 11  DC 3,004 2 2 

KY 60 3 10  Indian 

Territory 0 1 1 

Misc. 1 7 7  NC 2 1 1 

Canada 96 4 5  FL 3 1 1 

LA 1 4 4  IL 1 1 1 

OH 4 3 3  IN 4 1 1 

GA 8 2 2  KS 1 1 1 

     Total 3,605 165 208 

 

The article results are misleading without some additional explanation. Many of the articles 

compiled during research generalize about large numbers of runaway slaves in a single article. 

This is true for Kentucky (articles of 18 and 38), Canada (article with 94), Maryland (article with 

200), and Washington, D.C. (article with 3,000). There were two articles that speak to groups of 

22 and 25 runaways in Texas respectively. Without these outliers, most articles documented one 

or two runaway slaves. The adjusted total of runaways in articles is a much more modest 208. 

 

Table 9: Capture Notices by Place of Origin     Table 10: Advertisements by Place of Origin 

State Runaways Capture 

Notices 

Database 

Entries 

 State Runaways Advertise-

ments 

Database 

Entries 
TX 387 355 431  TX 693 609 921 

LA 79 85 98  LA 40 30 46 

AR 13 11 14  AR 12 12 16 
Indian 

Territory 16 6 13  TN 8 3 8 

MS 9 10 10  Indian 

Territory 2 4 4 

AL 4 7 7  AL 2 2 3 

NC 1 4 4  GA 1 1 1 

MO 2 2 2  MS 4 0 1 

SC 2 2 2  Total 762 661 1,000 

TN 2 1 2      

GA 1 1 1      

Total 516 484 584      

 

Even though there was some research on material from outside of Texas, Tables 9 and 10 

demonstrate that the overwhelming majority of runaways documented by the TRSP are from 

Texas. One thing that surprised the project manager during the compilation of this data for these 

tables was that there were only 20 instances where the same runaway slave had an advertisement 

and a capture notice (Alabama [1], Louisiana [2] and Texas [17]) made for them. There were 

also combinations of articles and advertisements (Texas [7] and Louisiana [8]) and articles and 

capture notices (Louisiana [1] and Texas [18]). 
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Table 11: Totals 
Location Runaways Articles/Ads/ 

Notices 

Database 

Entries 

TX 1,285 1,058 1,471 

LA 151 119 148 

AR 25 23 30 

Indian 

Territory 18 11 18 

MA 9 14 15 

NY 10 13 13 

Others 3,434 65 138 

Total 4,932 1,303 1,833 

 

The question that precipitated the results section of the final report was very simple: How many 

Texas runaways does the TRSP actually document? Answering this was the basis for Table 11. 

Texas runaway slaves account for 1,285 of 1,587 of the total documented (81 percent) when 

counting the outlying articles from Canada, Kentucky, Maryland, and Washington, D.C. as 

single runaways. Likewise, 81 percent of articles, advertisements and capture notices are from 

Texas and there are 1,471 Texas-specific database entries (80.2 percent).  

 

 

VI. Continuation of the Project 

 

The project manager is looking at all avenues to review the remaining microfilmed and original 

content. Nothing is in the works at the moment, but future collaboration seems like the most 

viable option. A significant quantity of the remaining research material is not at SFA. The 

project manager is open to working with students (any level) or faculty at other institutions to 

continue to populate the SFA dataset. The project manager is also interested in expanding the 

content of the TRSP from newspapers to court records and documents from archival manuscript 

collections.  

 

 

VII. Portraits of Freedom 

 

Portraits of Freedom, also organized by the project manager, is a juried student art exhibit of 

runaway slaves drawn from the newspaper advertisements aggregated by the TRSP. The exhibit 

will open in Nacogdoches June 13, 2015 at the Nacogdoches Railroad Depot and remain through 

September 25th. The exhibit will feature drawings, lithographs, paintings, screen-prints from art 

students at SFA, Texas Christian University (TCU) and Lamar University. An adjunct faculty 

member at the University of Texas at Arlington will also be contributing an illustration. The 

exhibit will also have interpretative panels to contextualize what’s on display. These will come 

from the collaborating faculty at TCU, the University of North Texas and the University of 

Texas at Tyler. 
  

There is an opening reception June 11, 5:00pm-7:30pm, at the Nacogdoches Courthouse Annex, 
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which will feature two lectures that place slavery and freedom in Texas within larger 

geographical contexts, as well as unveil several pieces from the exhibit. Dr. Douglas Chambers 

from the University of Southern Mississippi will speak about runaway slaves in the Atlantic 

World and Dr. Daina Berry from the University of Texas at Austin will lecture on Juneteenth.  

 

The exhibit is funded by $2,500 from the Ralph W. Steen Library. The speaker program is 

funded by a $1,000 grant from Humanities Texas. The Nacogdoches Chamber of Commerce is 

helping to promote the exhibit by making it the official art component of the 2015 Texas 

Blueberry Festival. This event draws 20,000 people to downtown Nacogdoches every year. 

Portraits of Freedom opens the same day.  

 

Figure A: Publicity Image, Portraits of Freedom 

 

 
Frances02 

Kim Jenkins, SFASU, Fall 2014 
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Clarksville Northern Standard 

November 20, 1844 – December 19, 1844 
 

 

VIII. Student Essays 

 

The project manager asked each student researcher to write a short essay on their experience 

with the project. The essay was not mandatory but four students submitted their thoughts. 

 

Student A 

 

When I told my grandmother that I was going to be working away my summer doing research 

for a Runaway Slave database, she asked me why we would work so hard to put something 

online that people could access for free. As a historian, I feel like that is my whole purpose.  Too 

many people are uninterested in the past, so collecting and republishing information for the 

purpose of genealogy, education, or other research moves the historical conversation forward. 

Working on the Texas Runaway Slave Project was my first experience with an archive and 

putting my love for history to work.  It’s one thing to study events of the past, but sifting through 

newspapers really made things come alive. 

 

One thing that I loved about looking at the old newspapers was how things never really change. 

The ads became more numerous, the print got smaller, and articles were being published about 

“what your eye color says about you!” It was almost like I was looking at the evolution of 

Facebook, but it was just a daily Texas newspaper from the 1840s. As soon as I came across 

what I was looking for, a Runaway Slave advertisement, I quickly realized how much times had 

changed. It is difficult for a modern person to try to process. Of course I knew there was slavery 

in the South, but the way it was so commonplace really surprised me. 

 

One interesting thing was that the slave owners were trying very hard to justify the fact that they 

owned other people. Runaway Slave ads were not altogether the same as estrayed or stolen horse 

ads. These owners knew the difference between animal property and a human being. This 

justification was especially evident within articles that explained how slaves that had run north 

had worse conditions where they were freed, and so they returned to their original plantation. 
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While I wouldn’t say that the circumstances were entirely falsified, white slave owners would be 

reading these articles, not potential runaway slaves. So, the purpose of these articles was not for 

warning the slaves, but a justification for the owners – the life they have on your farm is much 

better than a life of freedom.   

 

Overall I enjoyed my time working on the Texas Runaway Slave project. While it could be 

tedious looking through so many newspapers, it was a positive experience that brought a world 

that is so foreign to the 21
st
 century student to life. One thing to keep in mind is that these 

advertisements, articles, and capture notices did not come up in a vacuum. I would suggest 

looking at the full newspapers to get a sense of the context from which these excerpts came. The 

world was different from ours, but not so much that it is unrecognizable.  

 

Student B 

 

Working on this project was the experience of a lifetime and because of this opportunity I truly 

feel like I have given a voice to the thousands of runaway slaves documented. Over the duration 

of the project I began to imagine what horrendous circumstances the runaway slaves faced and 

how they might feel. I began to ask myself what would they eat and how would the stay dry and 

warm. Halfway through the project I began to cheer for the runaways and hoped they were not 

found. Each article documented tells a small portion of the runaway’s experience even though 

that was not its intended use. 

 

This experience was not only an educational experience but it also allowed me the opportunity to 

hone in my skills with various computer programs used to make the documenting process 

efficient. Half of the challenge was adhereing to the long list of  minute details and standards set 

by Kyle. Sifting through seemingly endless newspaper articles made for a tedious task and the 

only reward was actually finding a runaway slave advertisement. Finding an advertisement is 

where the real challege began. 

 

I hope that the work done is used to help other people in the quest for more information about 

this project.  

 

Student D 

 

As a member of the research team for the Runaway Slave Project, I found myself learning and 

enjoying it more than expected. It was interesting to see a part of history, in a different way. 

  

At times, it seemed overwhelming because of the amounts of newspaper issues that we needed to 

go through, but it was worth it in the end.  

 

It was exciting when I was scanning through what seemed like endless newspapers and then 

came across a new advertisement. Every advertisement was different from the rest. Some of the 

descriptions were extensive, and some seemed to not have any identifying information at all.  

One of the issues we began to see was the fact that the same advertisement for a runaway slave 

could have been copied into other newspapers during the same time. As the rest of the 

researchers found new runaway slave ads, we all had to do a quick search so that we could 
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identify if this was truly a new article, or a repeat of one previously found. I am glad that when I 

couldn’t clearly distinguish, I could just ask Kyle, and he would go through it with me.  

 

One of the most challenging parts was to mimic the article or advertisement as closely as 

possible in the transcript. This part of the research took the most time because of the amount of 

detail. We had to pick the right format, pick an image, if there was one, and then figure out the 

correct spacing. This was the most frustrating part. 

  

Overall, I am grateful I was given the opportunity to work on such a well-run project.  

 

Student E 

 

I enjoyed working on the TRSP this past May. Each student researcher received a long in-depth 

one-on-one training. They also received a detailed training packet that broke down each step. 

While working on the project it was clear that the priority was to go through as many newspapers 

as quickly as possible. However, each newspaper yielded plenty of usable historical information 

that would benefit scholars. Not getting distracted remained a challenge for me. Another 

challenge of the project was perfecting the format of each found slave ad in Microsoft Word. 

Aside from the mentioned challenges, the project ran smoothly and I was able to go through 210 

issues. It was especially fun when someone found a “new” slave advertisement. Due to the 

location of the newspaper publications, there were many slave advertisements that ran in 

multiple newspapers over lengthy periods.  

 

I enjoyed working on this project and am excited that it yielded so much usefully information. I 

hope that other institutions are able to continue the project nationwide in order to provided 

further information for families and researchers.  
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IX. Appendices 

 

A. Notable Runaway Slave Advertisements 

 

Caesar02 

Capture Notice 

State Gazette, March 13 - April 10, 1858 

 Capture Notice 

Dallas Herald, July 3 - August 21, 1858 

 

 

 
   

Sale Notice 

Dallas Herald, September 15 - 29, 1858 

 Report of Sale 

Dallas Herald, October 20, 1858 
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Cain01 
 

Runaway Advertisement 

Telegraph & Texas Register, 

October 9 - November 20, 1939 

 Runaway Advertisement 

Galveston Weekly News, 

November 3, 1857 

 

 

 

 
 

B. Photographs 
 

Figure B – Student Researchers, May 2014 
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C. Student Researcher Procedural Manual 
 

Note: This is the original procedure given to the students in May 2014. The naming and 

transcription guidelines have been modified and update since then. 
 

 
 

The Texas Runaway Slave Project 

East Texas Research Center 

Stephen F. Austin State University 

 
Welcome to the Texas Runaway Slave Project (TRSP) Team. This guide outlines the TRSP purpose and 

workflow. It will help orientate newcomers to the project and assist student as they begin their research.  

 
 

 

Project Manager: Kyle Ainsworth  

Special Collections Librarian 

East Texas Research Center 

ainswortk@sfasu.edu 

 

Content Manager: Dillon Wackerman 

Digital Archivist and Head 

Center for Digital Scholarship 

wackermad@sfasu.edu 

 

 

Table of Contents  
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  G. Content Upload……………………....... 31 

  H. Advanced Troubleshooting…….………. 32-33 
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I. Background 
 

A. Timeline 

 December 2012 – Project started by Kyle Ainsworth 

 August 2013 – Dillon Wackerman joins the project, begins developing the website 

 October 2013 – Website launched 

 January 2014 – Grant from the Summerlee Foundation awarded 

 May 2014 – Grant research commences 
 

B. Purpose 

Wherever there was slavery, there were runaways; wherever there were newspapers, there were 

runaway advertisements.  This project provides researchers the opportunity to investigate Texas history in 

an innovative environment. The student assistants will be able to use the project to prepare for their next 

step in academia or as valuable career experience. It gives the participants a chance to illuminate a 

brilliant but heretofore under-scrutinized primary source: colonial and antebellum newspaper 

advertisements. These provide a diverse audience of scholars, students, teachers, and genealogists world-

wide to learn more about the world of runaway slaves.  

 

C. Audience 

Students, teachers, genealogists, and scholars are just a few of the user groups that will use the 

Texas Runaway Slave Project. Because the TRSP is a digital humanities initiative, students and teachers 

at every level can access the student assistants’ runaway slave research through the classroom computer 

or lecture hall projector without coming to the archives. Genealogists will find the TRSP collection very 

useful. People researching their slave ancestry often can only find the names of their ancestors recorded in 

personal paper collections and court records. Even then, there is rarely a mention of descriptive 

characteristics. The runaway slave advertisements and notices often combine all these scant details into a 

succinct description of the slave that cannot be found anywhere else.  

 

D. Significance 

The access provided by the TRSP is remarkable in the context of the traditional sources of 

information about slaves. Scholars of slavery often utilize county records (probate and estate papers, court 

cases, and deed records), archival collections (personal and family manuscripts) and federal government 

records for their research. While county records and archival collections are excellent source material for 

scholars seeking information on a particular time and place, they often require meticulous on-site 

research. Records from the federal government are more widely accessible, but they have their own issues 

when it comes to doing research on slavery. Although the 1850 and 1860 U. S. Censuses have slave 

schedules, they do not generally provide any information about individual slaves, only the age, sex, color, 

and quantity of bondsmen owned by a particular individual. While researchers can discern detailed 

information about former slaves from the 1870 and 1880 U. S. Censuses, Freedmen’s Bureau Records, 

and Civil War pension records, these primary sources still leave much to be desired. 

Outside of the handful the slave narratives written while slavery was still legal in the United 

States and the more extensive WPA Slave Narratives, the aforementioned sources illustrate a body of 

primary sources that continue to frustrate all but the most determined researchers. Scholars have written 

extensively about how slaves lived (their family structure, folkways, leisure time, music, religion, etc.) 

and interacted with their owners (labor, resistance, sexual relations, etc.) but there is not very much about 

who these people were. What was their personality? What did they look like? What did they wear and 

what were the things they carried? These are just some of the questions that runaway slave advertisements 

and capture notices in newspapers can address. 

However, as the information on runaway slaves in newspapers is difficult to find and compile, it 

has about the same usefulness as county records. The aggregation of research in the TRSP is one solution 
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to this problem. It represents a conscious decision to make the project viable and immediately 

internationally accessible. The TRSP maps only a fraction of the slaves that were in Texas, but taken 

together they are an important “community” nevertheless that is now visible where once it was relatively 

invisible.   

 

E. Historical Context 

Historian Randolph Campbell writes that many Texans have a myopic notion of the role of 

slavery in the development of the state. This narrative looks to the frontier, the mythos and romanticism 

of the West, and dismisses the equally, if not greater, influence of antebellum Southern culture.
2
 

Campbell postulates that this is a defense mechanism, a way for Texans not to confront both the end of an 

economic, political and social institution that dominated Texas for 50 years (1816-1865) and the 

aftermath that continues to affect race relations to the present.
3
 

In fact, slavery is intimately intertwined into the early history of Texas. Over the course of 25 

years, the slave population in Texas grew from an estimated 5,000 in 1836 to nearly 170,000 in 1861.
4
 

Anglo-Americans that immigrated to Texas brought slaves with them. Campbell found that 77 percent of 

the heads of household in the 1860 census of Texas were born in the South. The state, with fertile soil and 

abundant land, was a natural frontier for the westward expansion of slavery. The success of cotton as a 

cash-crop encouraged the rapid growth of Texas. Clarksville newspaper editor Charles De Morse 

speculated in 1859 that there were not enough slaves in the entire South to satisfy the demand in Texas. 

“We doubt whether, in a hundred years, we shall have slave labor enough in Texas, to develop its 

resources.” Texans understood that slaves were the ultimate economic commodity because they could 

perform all manner of agricultural and domestic service, harvest the cash crop cotton, reproducing by 

natural increase, and increase in value as they grew to adulthood. From the same article, De Morse writes 

of slaves, “we need them” because “we desire the practicality; the increase of our productions; the 

increase of our comforts and wealth of the population; and if slavery, or slave labor, or Negro Apprentice 

labor ministers to this, why that is what we want.”
5
 In a very short time, Texas went from a society with 

slaves to a slave society.
6
  

 Although bondage by definition highly curtailed their free will, slaves still found many ways to 

create their own space. At work in the fields or in the house, with family and with friends, slaves asserted 

themselves and tested the master-slave relationship. “Running away” was one way slaves challenged the 

status quo. Slaves would visit friends on other nearby and regional plantations, but come back when they 

were ready to be “caught.” Mrs. R. Chambers advertised for her runaway slave Lee in the 1861 Bellville 

Countryman only to learn later when he was caught that he had been “about her premises” the entire three 

months.
7
 Other runaways in Texas were more ambitious, taking off to make a permanent escape. 

Runaways in Texas were liable to travel great distances. Owners documented in the TRSP data most often 

speculate that their bondsmen were headed for Mexico (where slavery was illegal), Indian Territory (to 

join the Choctaw Nation), to other plantations in Texas (to find family), or to other states (to find family). 

One planter even advertised that he thought his runaway slave might be making his way to Georgia.
8
 

 

 

                                                           
2 Campbell rhetorically notes that Texas identifies as Western and not Southern because his book is the very first history of 

slavery in Texas. By 1989, every other Southern slave state, except Texas and Delaware, had books on slavery in their state.   
3 C. Vann Woodward, The Burden of Southern History (Baton Rouge: Louisiana State University Press, 1960). 
4 Randolph B. Campbell, An Empire for Slavery: The Peculiar Institution in Texas, 1821-1865 (Baton Rouge: Louisiana State 

University Press, 1989), p.56, 252. 
5 Charles De Morse, “The Cloud in the Distance; and considerations connected therewith,” The Northern Standard, 19 February 

1859, p.2. 
6 Paraphrased and cited statistics in the first two paragraphs from the introduction and conclusion to Randolph B. Campbell, An 

Empire for Slavery: The Peculiar Institution in Texas, 1821-1865 (Baton Rouge: Louisiana State University Press, 1989), pp.1-4, 

252-259. 
7 The Bellville Countryman, 8 May 1861, p.3. 
8 Charles De Morse, “Ran Away,” The Northern Standard, 24 July 1847. 
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F. Work Plan 

 

Phase I: Digitized Newspapers – These are accessible from the home or office and exhausting this 

resource first is the most convenient. The University of North Texas (UNT) hosts two platforms, The 

Texas Digital Newspaper Project (https://tdnp.unt.edu/) and the Portal to Texas History 

(http://texashistory.unt.edu/), which have, at present, 7,594 issues scanned and searchable from Texas 

newspapers prior to 1865. A $10,000 grant from the Summerlee Foundation is helping to complete this 

portion of the project.  

 

Phase II: Microfilmed Newspapers – Some of what UNT does not have digitized is on microfilm. The 

plan is to use the microfilm available at the East Texas Research Center and through Interlibrary Loan, 

and then as travel as necessary when the materials are not in circulation.  

 

Phase III: Original Newspapers – Original newspapers are the least accessible of the research options 

available for this project. Institutions with major collections of pre-1865 Texas newspapers include the 

University of Texas at Austin, the Panhandle-Plains Museum in Canyon, Texas, and Yale University.  

 

 

II. Workflow 
 

A. Project Navigation  

 

Outlined below are is the computer drive map for all the folders that student researchers will need to use 

while working on the Texas Runaway Slave Project.  

 

Texas Runaway Slave Project Folder 

 > JPEGs and PDFs Folder 

  > Advertisement Images Folder 

   JPEGs Folder (Save PhotoShopped PDFs Here) 

   PDFs Folder (Save Screenshots Here) 

  > Advertisement Transcripts Folder 

   PDFs Folder (Save Transcript in PDF Here) 

   Word Folder (Save Transcript in Word Here) 

   Word Templates Folder (Find Transcript Templates Here) 

  > Runaway Images Folder (Has the Special Characters for Transcription)  

 > Student Workers Folder (Student Assistant Spreadsheets Saved Here) 

    

 

B. Search  
 

The dependability of the UNT-hosted websites is excellent for some search tools, but not for the most 

important aspects of this project. Keyword searches for “runaway” and “ranaway” yield results, but they 

are not comprehensive. Although the websites are text-searchable via Optical Character Recognition 

(OCR) software, the search engine has a very difficult time picking up the variable sizes, fonts, and image 

qualities of the digitized newspapers.  The keyword search is good for establishing a starting point, but 

ultimately each individual newspaper issue must be browsed to get a complete and accurate record. 

 

 

https://tdnp.unt.edu/
http://texashistory.unt.edu/
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1. Go to the Texas Digital Newspaper Project page http://tdnp.unt.edu/. Find the newspaper(s) assigned 

to you under “Titles.” 

 

 
 

2. Select the newspaper. It will redirect into the Portal to Texas History. It is easiest to find specific 

issues by: 

a. Sort by: Tab – Date Created (Oldest) 

b. Decade Tab – Select a Decade. It will then organize by Year. 

http://tdnp.unt.edu/
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3. Click the large image on Subpage A. 

 

 

Subpage A 
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4. Subpage B will open up. Click “Zoom Full Page.” Subpage C will open.  

 

 

Subpage B 
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Subpage C 
 

5. On Subpage C, manipulate the image with the Zoom control (left) and change pages with the 

Sequence box. 

6. Browsing: What are we looking for? 

a. Runaway Slave Advertisements  

b. Runaway Slave Capture Notices 

c. Articles about Runaway Slaves 

d. Other Articles. If you see something that could be tangentially related to the project (i.e. news 

of a slave insurrection/revolt, capture of a slaver vessel, etc.), make a note of the page, 
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column # and title of the article in the “Notes” section of your Excel spreadsheet (see below). 

This information may be used at a later date. 

7. What is the best way to search? Browse the newspapers in the TDNP. The zoom required to see the 

newspapers clearly will depend on the clarity of the digitization, the width of the newspaper 

(anywhere from 3 to 8 columns of text), and your eye sight. Scroll through 2-3 columns of text at a 

time looking for keywords like “runaway”, “slave”, “negro”, “committed”, “taken up”, etc.  

8. Should I read every word on every page? No. Scan for the keywords. Advertisements and capture 

notices tend to be near the end of the newspaper. Articles can be anywhere, so it is important to be 

diligent and not cut corners. 

9. What if the digitized newspaper page on the TDNP is illegible? This happens all the time. A lot of the 

newspapers were scanned from microfilm, which aren’t always the best quality. Please write down 

the page where there is illegible, missing, or torn in the “Notes” section of your Excel Spreadsheet. 

There may be a copy or original somewhere that will be in better condition. 

 

 
 

10. What if there is an error message or blank screen when opening or zooming in on a particular 

newspaper issue. 

a. Use the “Sequence” box (Subpage C) to view the other pages of the issues. Sometimes there 

is an error message for only one of the pages, but the rest display correctly. 

b. Try to view the newspaper from Subpage B. Keyboard “Control +” to magnify the page. 

There is also a “Sequence” box on Subpage B. Sometimes the image will be clear enough to 

browse the newspaper from here.  

 

C. Description  
 

All the text information in the TRSP website originates in a Microsoft Excel spreadsheet. Each student 

worker will work within Excel to document runaway slaves and their overall progress on the project. If an 

advertisement is for a group of slaves, make a separate row for each individual slave. This is best seen in 

the example below from January 20, 1838. Although Joe and Henry are named in the same capture notice, 

each gets their own row. Also, there is a separate third row for repeat runaway slave advertisements that 

appeared in that issue. We do not the information in the third row to end up on the website. 

 

W:Kyle\Texas Runaway Slave Project\Student Workers\Your Name 

 

Fields  

1. Set Upload – Don’t worry about this until your data set is confirmed to be on the webpage. 

2. Newspaper Title – Input for the first newspaper in the series and every issue where there is an 

advertisement, notice or article. 

3. Newspaper Editor – Input for the first newspaper in the series and every issue where there is an 

advertisement, notice or article. 

4. Newspaper Location – Input for the first newspaper in the series and every issue where there is an 

advertisement, notice or article. Write down in this format: City, County, State. 

5. Newspaper Language – Input for the first newspaper in the series and every issue where there is an 

advertisement, notice or article. 
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Key 

 Uploaded to the website. 

 Reviewed issues. In such a massive spreadsheet, this helps distinguish completed projects. 

 Second batch awaiting upload to the website. This includes corrections to material already online. 

 Third batch awaiting upload to the website. This includes corrections to material already online. 

 Edits to finished 

batches.  

   These changes need to be made to the web 

content. 

 Internal organizational fields deleted when the spreadsheet is published to the website. 

 

6. Volume, Issue – Enter this information before reviewing each issue. The entry of this data is another 

way (along with the forest green color-coding) to keep your place as you work through a newspaper 

collection.  

7. Newspaper Date – Edit as necessary. Typos are common. 

8. Associated Date – Decade range. Only input this information for runaway slave advertisements, 

notices and articles. 

9. Viewed-In Format – Input either Digital or Microfilm for each runaway slave advertisements, 

notices and articles. 

10. Format Repository Locations [Digital, Microfilm, Original] – The abbreviations denote where a 

copy of the issue can be found. All the digitized issues on the TDNP should be pre-entered into the 

database. The repositories are inventoried on the second page of the spreadsheet. 

 

 
11. Host Institution - The name of the institution that provided the newspaper for viewing. 
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12. Hyperlink – Input the web address for the newspaper page with the advertisement, article or notice. 

Copy the URL into the Excel text box and hit ENTER. It should automatically add the http:// in from 

of the web address. 

 

 
 

 
 

13. Type – Input Advertisement (by owners), Notice (by captors), or Article (from the newspaper).  

 

For organizational purposes, this is where all the Y’s (Yes, there is a runaway slave advertisement, but 

it is a repeat) and N’s (No, there are no runaway slave advertisements in this issue) go. This 

information will not go online, but helps the researcher keep track of their progress. 

 

14. Title – Title of the runaway slave advertisement, notice or article. 

15. Page, Column – Input like this: pg.2, col.4 

16. Reward – Input the amount offered for the capture of the runaway slave. Separate different amounts 

with a semi-colon and a space.  

17. Description – Input a corrected transcription of the advertisement, article or notice. Fix spelling and 

punctuation errors and write out all abbreviations (usually first names and months). The text should 

all run together, so do not indent for new paragraphs.  

18. Repetition – One of the biggest challenges in the project is to avoid the duplication of records for 

individual runaway slaves. The project wants to record the first iteration/appearance of each 

advertisement. In this field, note every repetition of the original. Format like this: mm/dd/yyyy (pg.#, 

col.#). 
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19. Description – Input a corrected transcription of the advertisement (Correct spelling, fix punctuation, 

spell-out abbreviations).   

20. Runaway’s Name – Input the runaway’s name. This is the principle organizing field for the project. 

a. If the advertisement does not give a name, enter “Unnamed.’ 

b. If more than one name is given for the same person, enter both and separate them with a 

semicolon. 

c. If there is more than one runaway slave in the advertisement, insert a new row in the 

spreadsheet and copy the information from #s 1-19. Every individual runaway slave gets their 

own entry in the database. 

21. Sex – Input Male or Female. 

22. Age – Input the runaway’s age. If more than one age is given, enter both and separate them with a 

semicolon. 

23. Height – Input the runaway’s height. If more than one height is given, enter each one and separate 

with a semicolon. Format like this: 6’ 2”. 

24. Weight – Input the runaway’s weight. If more than one weight is given, enter each and separate with 

a semicolon.  

25. Complexion. The word used to describe the slave’s skin tone. Input the runaway’s complexion, 

including gradations of light and dark (i.e. light copper or dark mulatto). 

26. Runaway’s Language  - Input the runaway’s language. DO NOT MAKE ASSUMPTIONS. Only 

enter information for this field if it is specifically listed in the advertisement. 

27. Runaway’s Education/Trade Skills – If the advertisement indicates that the runaway can read, 

write, do figures, or has a job or trade skill, enter that information in this field. Separate each skill 

with a semicolon. 

28. Possessions – Input here whatever the advertisement says the runaway stole or took with them, 

including clothes, tools and animals. Separate each possession with a semicolon. 

29. Number of Runaways – Enter Single (1), Pair (2), or Group (3 or more) depending on the 

advertisement. 

30. Submitted By – Input the name of the person who submitted the advertisement, article, or notice to 

the newspaper. 

31. Location of Submitter – Enter in this format: Town, ABCD County, State. For towns that you are 

not familiar with, double-check them on Google and in Google Maps. It may be that the town exists, 

but it is in a new county. Input the new county. If you can’t find the town on the map, default to the 

county.   

32. Captor – Input the name of the person in newspaper capture notice’s ONLY that caught the runaway 

slave. 

33. Location of Capture – Enter in the same format as Field #31. 

34. Slave-owner - Input the name of the person who owns the runaway slave.  

35. Location of Slave-owner – Enter in the same format as Field #31.  

36. Previous Slave-owner – Sometimes advertisements will give this additional detail.  

37. Location of Previous Slave-owner – Enter in the same format as Field #31. 

38. Contributor – Enter your name for each distinct runaway slave advertisement, article or notice that 

you find. 

39. Grant Funding – “The Summerlee Foundation funded student research on this entry to the Texas 

Runaway Slave Project. For more information on the Summerlee Foundation, please visit their 

website http://www.summerlee.org/.” 

40. Rights – “This item may be protected under Title 17 of the U.S. Copyright Law. It is available for 

non-commercial research and education. For permission to publish or reproduce, please contact the 

East Texas Research Center at asketrc@sfasu.edu.” 

41. Image – See Imaging, Section 2f. 

 

http://www.summerlee.org/
mailto:asketrc@sfasu.edu
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For Object File Name (#42) and Transcript File Name (#43), consult the JPEG folder: 

Texas Runaway Slave Project > JPEGS and PDFs > Advertisement Images > JPEGs 

Check for the name of your runaway slave. The file name will depend on the existing records: 

 

a) New Name: Append “01” to the runaway’s name. 

b) Repeat Name, New Runaway: Add whatever the next number in the sequence is to your 

runaway’s name. (i.e. Jim04). 

c) Repeat Name, Previously Recorded Runaway: This is where it gets tricky. See Section I 

below. 

42. Transcript File Name – Input “RunawayName00.pdf.”  

43. Object File Name – Enter “RunawayName00.jpg.” 

44. Object Identifier – This is just a sequence number that identifies the order in which records are being 

found for the project. When you make a screenshot of the advertisement in Word and save it as a 

PDF, the title of that PDF will be this number. Find the most up-to-date number here (should look 

like 00132):  

etrc(\\steenlibrary\r) (W:) > Kyle > Texas Runaway Slave Project > JPEGS and 

PDFs > Advertisement Images > PDFs 

45. Notes – If you see something that could be tangentially related to the project (i.e. news of a slave 

insurrection/revolt, capture of a slaver vessel, etc.), write down the page, column # and title of the 

advertisement or article here. 

 

D. Imaging  

 

1. Digitized Newspaper: Making a screenshot in Microsoft Word. 

a. Zoom in on the advertisement as far as you can. 

b. Open a Microsoft Word document. In Page Layout tab, change the margins to “Narrow” and 

the orientation to “Landscape.” Next, insert the screenshot of the advertisement. 
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c. Crop the screenshot to the edges of the borders of the advertisement. Right click the image 

and scroll down the list that pops up and click Format.  Set the width of the image to fit the 

document margins. 

 

     
 

d. Click File. Click Save As and save the folder to the Advertisement Images PDF folder. 

i. Go to Texas Runaway Slave Project > JPEGs and PDFs > Advertisement Images 

> PDFs. 

ii. Use the file name assigned to the advertisement in Field #44. 

iii. In the Save as Type box at the bottom, select PDF. 

iv. Save. 

 

2. Digitized Newspaper: Converting a PDF to JPEG in Adobe PhotoShop 

a. Open PhotoShop. Click File and then click Open. Follow the same Folder path from above. 

b. Select the appropriate PDF and open the file. There should be a checkerboard pattern along 

the bottom and right edges that needs to be cropped off.  

c. To crop the advertisement image, make sure the Rectangular Marquee Tool is selected. Use 

the mouse to outline the advertisement, enclosing everything that needs to be saved. Click 

Image on the tool bar and scroll down to Crop.  

d. Click Image on the toolbar and scroll down to Adjustments and then scroll down to the 

second entry on the pop-up list for Auto Levels. 

e. Click File, Click Save As, and save the folder to the Advertisement Images JPEG folder. 

i. Go to Texas Runaway Slave Project > JPEGs and PDFs > Advertisement Images 

> JPEGs. 

ii. Use the file name assigned to the advertisement in Field #43. 

iii. In the Format box at the bottom, select JPEG. 

iv. Save. 

f. For the Excel Spreadsheet (Field #41), click the tab for Insert on the taskbar, select Picture 

and select the newly created JPEG. Right click the image and scroll down the list that pops up 

and click Size and Properties.  Set the width of the image to 2 inches. 

 

3. Microfilmed Newspaper – Newer microfilm readers allow users to make high quality scans of the 

screen contents in multiple image formats. 

4. Original Newspapers – Digital camera adjusted for non-flash photography. 

 

E. Transcription  

 

The true transcription reflects the printed composition of the advertisement as closely as possible. It 

shows all line breaks and font variation and keeps hyphenated and abbreviated words, as well as spelling 

errors, intact. The TRSP also includes the special characters, like the miniature image of a runaway slave, 
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which many of the records have. Creation of the true transcripts is laborious, but a nice touch to the 

website.  

 

1. Template Selection – The TRSP has Microsoft Word tables created for the five most common formats 

for runaway advertisements, articles and notices. Go to Texas Runaway Slave Project > JPEGs and 

PDFs > Advertisement Transcripts > Word Templates. Open the appropriate template. 

2. Copy the corrected transcript from the Excel spreadsheet (Field #19) into the space below the 

template table. Change the font and size to 14-point Baskerville Old Face. Some of the titles and 

oversize lettering may look closer to the original lettering in Bodoni MT, Bodoni MT Black and 

Blackoak Std. Change as necessary. Use the original advertisement and the diagram below to dictate 

where the different words belong in the template.  

DIAGRAM  Use the Original to Fill the Template 

 

 
$50 REWARD-Ranaway from the subscriber, a negro girl Maranda, of dark complexion, rather 

low, and heavy built, about nineteen years old, formerly the property of Lewis Knight, of this 

county; said girl carried off, when she left, two domestic dresses, one plaid blue and red 

domestic dress, one black silk dress, one black muslin dress. The above reward of Fifty Dollars 

will be paid to the person who may detain said girl, so I can obtain her. ROBERT F. 

MILLARD. Nacogdoches, nov2 272-tf 
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3. Undo Corrections – This is the true transcription, so undo all the corrections made in the Excel 

spreadsheet. 

4. Re-Size the Table – Adjust the sizes of the columns and rows as necessary to fit the advertisement. 

This is VERY TRICKY and will take some practice. 

5. Justify – Once the text is copied into the table, click the Justify button on the toolbar to align text on 

the right and left margins like a newspaper. You may need to use the space bar some to get the text to 

align better. 

 

 
 

6. Hide the table borders. Right click the top left of the table and scroll down to Table Properties. In 

the new window, select the button for Borders and Shading at the bottom and click. In that window, 

select the “None” button and click Okay.  

7. Click File and Save As. The file to save to is at Texas Runaway Slave Project > JPEGs and PDFs 

> Advertisement Transcripts > Word  
8. Save As “Transcript – RunawayName 00” in Microsoft Word.  

9. Click File and Save As. The file to save to is at Texas Runaway Slave Project > JPEGs and PDFs 

> Advertisement Transcripts > PDFs 
10. Save As “RunawayName 00” as a PDF. 

  

F. Maps  
 

The Texas Runaway Slave Project has five associated location fields. These are input into Google Fusion 

Tables spreadsheets, along with other select fields, to give the researcher a dynamic visual way to 

understand runaway slave activity. The Content Manager will manage the map section. 

 

G. Content Upload  
 

All the project data is entered into an Excel spreadsheet. It includes all the aforementioned fields, as well 

as several administrative fields. To upload the spreadsheet to ContentDM, a copy is made, the 

administrative fields are deleted, and the spreadsheet is saved as a tab-delineated text file. The Content 

Manager will handle this task. 
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H. Advanced Troubleshooting - When a student researcher finds a Repeat Name, Previously 

Recorded Runaway in the JPEG sub-folder of the Advertisement Images folder, there are several 

things they need to do: 

 

 
 

1. Look at the new record. It should be a: 

a. Different Format (i.e. Bob below, where there is an advertisement and a capture notice).  

 

  

Here, there is an 

advertisement and a 

capture notice. 

Observe above how 

they are entered in 

the JPEG folder 

above.  

Bob 03 (Advertisement) Bob 03 (Notice) 

 

b. Same Format, but with different text (i.e. Abram and Gabriel below, where there is more 

text, less text, a title, no title, an image, not an image, a change in the page breaks, or an 

increase in the award amount).  

 

 

 

 

Here, there is an 

advertisement 

which ran in the 

same newspaper 

but was revised 

three times. 

Abram 01 (a) Abram 01 (b) Abram 01 (c) 
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Here, the text in 

a), b) and c) does 

not change, but 

the layout does. 

Each gets its own 

entry in the 

spreadsheet. 

Advertisements 

like Gabriel’s are 

why this project 

is so labor-

intensive. 

Researchers need 

to notice these 

subtle changes as 

they work. 

Gabriel 01 (a) Gabriel 01 (b) 

  
Gabriel 01 (c) Gabriel 01 (d) 

 

c. Different Formats and Different Texts – Gumby is the best example. Edwin Waller ran an 

advertisement for two years in Houston and other regional newspapers hoping to catch 

Gumby. 

  

Gumby 01 ($50) Gumby 01 ($200a) Gumby 01 ($500a) 

Gumby 01 ($100) Gumby 01 ($200b) Gumby 01 ($500b) 

 Gumby 01 ($200c) Gumby 01 ($500c) 

  

2. The student researcher should: 

a. Enter their data in the Excel Spreadsheet. Save the advertisement image as a JPEG 

b. The transcripts for runaway slaves with multiple entries are all combined into one document. 

Use the PDF transcript for Gumby as a template: 

 
c. Let the project manager know that the compound object online needs to be updated with the 

new JPEG image and revised transcript. 
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